Welcome to our BRAND GUIDELINES

Consistency in what we say, how we say it, and how we look defines how the public views us. Use this style guide to help you write and create material that inspires confidence in the University of Hartford.

This guide is a living document, and will be updated often. Please contact the Office of Marketing and Communication for the most up-to-date version.
Q U E S T I O N S ? J U S T A S K.

If you’re looking for resources, or simply have questions about the brand, please contact:

Molly Polk
Vice President for Marketing and Communication
mpolk@hartford.edu
860.768.4267

Paula Ribeiro
Director of Brand Strategy
pribeiro@hartford.edu
860.768.4379

N O T E

Some sections of this guide have been eliminated for space. For a complete guide, contact Paula Ribeiro, pribeiro@hartford.edu.

N O T E

Certain photographs that appear in this document are used solely as brand examples. The University does not own the artistic rights for their use in other communications, and they should serve only to guide photo style.

04 | OVERVIEW | 65 | GRAPHIC ELEMENTS

What is a brand?
Why is a brand important?

27 | LOGOS/GRAPHIC IDENTIFIERS

Logo Variation and Logo Usage Overview
Logo + School Name

37 | COLOR

Primary
Secondary
Neutral
Gradients
Using Color
Sample Color Palettes
Color Palette Flexibility
Duotone Photos

53 | TYPOGRAPHY

Primary Typeface: Gotham
Accent Typeface: Vitesse
Sample Typesetting
Leading
Tracking
Outlined Type

77 | PHOTOGRAPHY

Students
Faculty and Alumni
Place
Details
Duotones

103 | DESIGN CONSIDERATIONS

Design Elements
Templates
Creative Brief
Paper Stock Choices
Trademark Usage Guidelines
Student Use of Trademarks
OVERVIEW

WHAT IS A BRAND?

A brand is an enduring platform that articulates an organization’s unique identity and point of view. It can help an organization connect with many audiences through informed and relevant interactions.

At the University of Hartford, our brand focuses on our distinct and diverse array of opportunities and the common vision that unites us as a community of multifaceted makers.

WHY IS A BRAND IMPORTANT?

As humans, we form opinions very quickly, and they lend heavy influence to the decisions we make. That’s why it’s critical for the University to create positive and meaningful interactions as often as possible.

Our brand works by forming emotional connections from the very first interaction—whether that’s a billboard in West Hartford or an inquiry about a program from a potential student. These interactions accumulate and shape the opinions of those we serve.

The elements in this document work together to ensure that all of these encounters align and convey a compelling story about UHart. The principles apply to all of us, to every interaction, and to every piece of communication.

This document is designed to help you make decisions in support of our story. There’s a deeply informed rationale for everything here—every visual and verbal element. These pages reflect the thought process that went into developing the brand and offer guidance for making it work.
OVERVIEW
Our logos represent the University of Hartford at the highest level.

The University wordmark is our primary logo. It acts as a signature, an identifier, and a stamp of quality. It should be used consistently throughout our communications.

This section details appropriate ways to use the University wordmark and other University marks.
The official wordmark and trademark of the University of Hartford is composed of two parts—the words “University of Hartford” and the anchor bar—in a certain configuration. This trademark represents the University and must be used in all instances of marketing and identifying of the University.

The sans-serif typeface provides a modern, forward-looking tone that is part of the University of Hartford’s overall identity. The anchor bar that grounds the two elements together is accented with a centered, directional arrow that suggests the idea of focused support.

There are two formats of the mark: stacked and linear. Though the stacked version is preferred, use the format that fits best in the space, making sure that the wordmark is prominent and readable.

The wordmark must be used according to the University’s approved graphic standards. It must not be re-keyed, redrawn, reproportioned, added to, or modified in any way. It is the official trademark of the University of Hartford and must be reproduced from original artwork. Only the official, approved versions of the wordmark are appropriate for use. The Office of Marketing and Communication is responsible for establishing and maintaining these graphic standards.
By choosing to place the words “University of Hartford” prominently on top of the anchor bar, supported by the individual school or college name below, we symbolize how each individual entity contributes to the greater institution.

Each school and college has a designated wordmark lockup. No other mark should be used to represent individual schools, colleges, departments, or programs.

The following page provides further guidelines about how to use these college and school lockups, and when it is acceptable to use the standalone University wordmark.

Please contact the Office of Marketing and Communication for the appropriate wordmark for your office.
SEPARATING THE SCHOOL FROM THE WORDMARK

AUDIENCE AND FAMILIARITY
Before using this treatment, consider the audience and their level of familiarity with the University of Hartford, as well as their familiarity with the particular college or school. The more familiar they are, the better. If it is a first communication or a more formal communication, it is best to use the full lockup.

SIZE AND CLEAR SPACE
Both the school name and the wordmark should be featured prominently, but avoid placing them too close in size or proximity, as outlined by the logo architecture rules in these guidelines. If space is limited, use the school or college’s lockup.

APPROPRIATE USES
More general and brief communications (such as fliers, postcards, or news) should typically lead with the school or college’s lockup. More robust and showcase pieces for individual schools (such as viewbooks, event promos, posters, or on-campus communications) can lead with the school name, supported by the standalone University wordmark.

In some instances, the University of Hartford’s seven colleges and schools can feature their own name separately from the University wordmark. Please note that this applies only to the seven colleges and schools, and not to specific programs within each of those schools. If you are unsure whether you should use this treatment, using the school or college’s lockup is always safe.

AUDIENCE AND FAMILIARITY

SIZE AND CLEAR SPACE

APPROPRIATE USES
UNIVERSITY SEAL
The University of Hartford seal represents the official business of the college. It symbolizes a sense of tradition and excellence. However, it should not be used as the University’s logo.

Appropriate uses of the seal are limited to commencement activities and official documents, such as student transcripts, diplomas, certificates, and formal awards with inscriptions. The Office of Marketing and Communication oversees the use of the University seal.

BLOCK H
A shorthand symbol for the University is the Block H. It represents our strength, unity, and spirit. It’s truly an iconic identifier for the University.

For guidance on using the Block H with the University wordmark, see page 35.

For guidance on using the Block H as an icon, see page 69.

For guidance on using the Block H as an interactive photographic element, see page 70.

HARTFORD HAWKS
The Hartford Hawks logos may be used only by those with written authorization from the University of Hartford Department of Athletics and only in accordance with the guidelines set forth in the Hartford Hawks Brand + Identity Guide document.

Neither the Hartford Hawks logo nor any of its supporting marks may be used for academic or institutional purposes other than to identify the Athletics Department and the varsity athletic teams.

Contact the Department of Athletics Office of Communication for a copy of the Hartford Hawks Brand + Identity Guide.
USING THE WORDMARK SIZE AND CLEAR SPACE

MINIMUM SIZE

The stacked version of the wordmark should not be used smaller than one inch wide, and the linear version should not be used smaller than two inches wide.

Proportional Resizing

The wordmark must always be resized in proportion. To do this, hold the shift key down when resizing. If the wordmark looks squished or stretched, it is incorrect.

CLEAR SPACE AND STAGING

The University of Hartford wordmark looks best with ample clear space around it. Use at least double the cap height of the letter “O” from the wordmark for proper clear space.

As a graphic element, the wordmark should be part of the overall design of a page, to readily identify the University. It should be proportionately large enough to anchor the design.

Avoid Edges

Do not put the wordmark or any lockup at the edge of the document or near other elements.

Tallest Character

The S in “university” is the tallest character. Use this as the reference point when setting clear space.

USING WITH OTHER LOGOS

When another logo is used with the wordmark, the University of Hartford mark should appear larger, should be positioned first, and should keep space that is at least four times the width of the letter O (from the wordmark) between it and any other logo.

Optically Centered

Be sure that the logos look centered vertically. Do this optically, because the University wordmark is bottom-heavy, so other logos that are metrically centered to it may look slightly off.

Rule Lines

Alternatively, use two widths of the O, followed by a vertical rule line, and then two more widths of the O.

Both Sides

These clear space rules apply to both sides of the University wordmark, and to both the vertical and horizontal versions.
The examples on this page are not the only appropriate color combinations, but they are good references. Use them as a guide and keep legibility at the front of your mind when deciding which color wordmark to use.

OVERVIEW

Use the UHart Red version of our wordmark whenever possible. But be careful: red is prone to strong vibration when used with other colors, especially green.

The wordmark should almost always be white when placed on top of red, black, and dark secondary color floods, as well as any pattern, or any gradient. It’s best to use the black wordmark on light color floods, but red can be used as long as it doesn’t vibrate.

Best practice is to use the white wordmark over photography. Look for clear space to place the wordmark, or some place that isn’t too busy with color and texture. Having proper contrast between the wordmark and background is paramount.

In cases where there isn’t enough contrast, the first choice should be to increase contrast between the wordmark and the photo, through the use of photo editing or multiplied overlays. If that doesn’t work, use the red or black wordmark and further adjust the contrast as needed.
It is important to reproduce the wordmark consistently in order to maintain brand equity. It should never be altered in color or proportion, unless explicitly stated otherwise in these guidelines.

This page shows some practices that should be avoided when using the University’s marks.

**Do not** crop the wordmark.

**Do not** rotate the wordmark.

**Do not** use drop shadows, strokes, or other visual effects.

**Do not** add colors to individual elements.

**Do not** use colors other than those specified by these guidelines (see page 37).

**Do not** use any of Athletics marks or the seal in place of the University wordmark.

**Do not** stretch or condense the wordmark.

**Do not** alter or replace the typeface of the wordmark.

**Do not** skew or bend the wordmark.

**Do not** rearrange the placement of the type or anchor bar in the wordmark.

**Do not** alter the scale or proportions of the type or anchor bar in the wordmark.

**Do not** add any extra elements to the wordmark.
When using both the University wordmark and the Block H, consider the audience, formality, size, and format. The Block H should never be placed directly next to wordmark, especially if they are similar in size. When they’re used together, it should be clear that the Block H is a graphic element and not a logo. For more details on using the Block H as a graphic element, see the Graphic Elements section.

Clear contrast in size. Each has its own clear space, despite large the amount of space the Block H occupies.

Similar in size, but separated by space and content.

Clear differentiation in size.

Despite the contrast in size, the placement of the wordmark within the Block H makes them feel like a logo lockup.

Too similar in size, too close in proximity. Looks like a cumbersome logo lockup.

Too similar in size and looks like a logo lockup. Plus the legibility and impact of the Block H gets lost behind the wordmark.
OVERVIEW

Our color palette has two main layers: primary and secondary. Communications should lean heavily on the primary palette, but may use the secondary, neutral, and gradient palettes to keep layouts from becoming too stale or one-dimensional.

When using color builds, always use the values listed on the following pages. They have been adjusted for the best reproduction on screen and in print, and may not match Pantone Color Bridge breakdowns.

CUSTOM BUILDS

All CMYK and Pantone formulas are for uncoated paper stock.
Our primary palette consists of UHart Red, white, and black. Layouts lean heavily on these colors, but can also mix them with the secondary palette to build color schemes that are complementary and balanced.

### UHART RED

- **CMYK UNCOATED**: 0 95 94 2
- **CMYK COATED**: 6 98 100 0
- **RGB**: 218 26 50
- **HEX**: DA1A32
- **PMS**: 186

### WHITE

- **CMYK**: 00 00 00 00
- **RGB**: 255 255 255
- **HEX**: FFFFFF

### BLACK

- **CMYK**: 60 40 40 100
- **RGB**: 00 00 00
- **HEX**: 000000
Colors from the secondary palette may be used with UHart Red, but they can also pair with each other to create a variety of effects for many needs and scenarios. Striking a balance between light, vibrant, and muted tones offers the flexibility to compositions that are bolder and more vibrant, or more formal and reserved. To see the color palette applied in layout, see the Sample Tactics section.
Use these neutral tones to support and balance UHart Red and the secondary palette.
Gradients add vibrancy and depth to compositions. They serve as a visual metaphor for the blending of ideas and perspectives. These gradients can be used as accents or floods, but should be balanced thoughtfully with the rest of the color palette.
Use the provided gradient swatches whenever possible, but some manual adjustments may need to be made. Use this page when determining percentages, angles, and placement.

**NOTE**

It’s not necessary to be precise, but try to maintain visual consistency at different scales. The lighter color should dominate, and the transition to the dark color should be smooth.

Be consistent with the direction of color, too. Generally, the lighter color should be to the top and left, while the darker color should be to the bottom and right.
HOW TO USE GRADIENTS

This page offers a high-level overview for using gradients in compositions. These comps are oversimplified for illustrative purposes, but show some examples of how gradients can be used.

See the Sample Tactics section for more detailed examples of gradients being used in layout.

Patterns can be used with gradients as well, but only in specific colors combinations. See page 66 which details how to use color with patterns.
Use this page as a general guide for using red text with the secondary palette. Each use case is unique and depends on text weight and scale. Use your best judgment and be sure legibility is your top priority. Please note that these guidelines do not consider ADA compliance.

**GOOD** This combination is good to use on this medium

**AVOID** This combination vibrates slightly compromising legibility; avoid using this combination unless vibration is desired

**BAD** This combination vibrates extremely, do not use

<table>
<thead>
<tr>
<th></th>
<th>GOOD</th>
<th>AVOID</th>
<th>BAD</th>
<th>GOOD</th>
<th>AVOID</th>
<th>BAD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>~</td>
<td></td>
<td></td>
<td>~</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>~</td>
<td></td>
<td></td>
<td>~</td>
<td></td>
<td>~</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>~</td>
<td></td>
<td></td>
<td>~</td>
<td></td>
<td>~</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>~</td>
<td></td>
<td></td>
<td>~</td>
<td></td>
<td>~</td>
</tr>
</tbody>
</table>
**USING RED TEXT ON COLORED BACKGROUNDS**

Use this page as a general guide for using red text with the secondary palette. Each use case is unique and depends on text weight and scale. Use your best judgment and be sure legibility is your top priority. Please note that these guidelines do not consider ADA compliance.

**GOOD** This combination is good to use on this medium
**AVOID** This combination vibrates slightly compromising legibility; avoid using this combination unless vibration is desired
**BAD** This combination vibrates extremely, do not use

<table>
<thead>
<tr>
<th>HEAVY TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MEDIUM TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Text</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HEAVY TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MEDIUM TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Text</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HEAVY TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MEDIUM TEXT</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light Text</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Use this page as a general guide for using colored text with red backgrounds. Each use case is unique and depends on text weight and scale. Use your best judgment and be sure legibility is your top priority. Please note that these guidelines do not consider ADA compliance.

**GOOD** This combination is good to use on this medium

**AVOID** This combination vibrates slightly compromising legibility; avoid using this combination unless vibration is desired

**BAD** This combination vibrates extremely, do not use

<table>
<thead>
<tr>
<th></th>
<th>PRINT</th>
<th></th>
<th>DIGITAL</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GOOD</td>
<td>AVOID</td>
<td>BAD</td>
<td>GOOD</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>~</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Light Text</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Light Text</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td></td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light Text</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Light Text</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[COLOR]
Use this page as a general guide for using colored text with red backgrounds. Each use case is unique and depends on text weight and scale. Use your best judgment and be sure legibility is your top priority. Please note that these guidelines do not consider ADA compliance.

- **GOOD**: This combination is good to use on this medium
- **AVOID**: This combination vibrates slightly compromising legibility; avoid using this combination unless vibration is desired
- **BAD**: This combination vibrates extremely, do not use

<table>
<thead>
<tr>
<th>TEXT TYPE</th>
<th>PRINT</th>
<th>DIGITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td>Light Text</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td>Light Text</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td>~</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td>Light Text</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Light Text</td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td><strong>HEAVY TEXT</strong></td>
<td>~</td>
<td>X</td>
</tr>
<tr>
<td><strong>MEDIUM TEXT</strong></td>
<td>~</td>
<td>X</td>
</tr>
<tr>
<td>Light Text</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Red and white should always lead on formal and external communications, but there are many options for creating secondary color palettes. This page shows acceptable color combinations, but that doesn’t mean that every color in each group should be used equally. For more examples of how to apply color palettes, see the Sample Tactics section. For a general guide on formality and boldness, see page 51.
This chart is a guide for the moods that our color palettes can create. Colors can range from formal to casual and from reserved to bold. This chart is not all-encompassing, but provides a general sense for how color groups feel. Our secondary palette skews towards bold and casual, so use more red and white in formal communications. See the Sample Tactics section for color application examples.
This page shows a high-level example of how the color palette can flex. The first example leans on UHart Red and a neutral. The second leads with red and incorporates two bold accent colors. The third example leads with a secondary color supported by red. The fourth uses a bold color combination that is completely devoid of red; a piece like this would require external context to identify as UHart, such as an enclosing folder.
There are special specifications for branded merchandise, such as ink and embroidery thread colors. UHart Red, black, white, and grey are the primary colors permitted for merchandise; special exceptions such as merchandise promoting breast cancer awareness or celebrating holidays are permitted on a case-by-case basis. Merchandise must be ordered only from the University’s approved vendors.

**UHART RED**

FOR MERCHANDISE AND APPAREL, USE PMS 186

**WHITE**

CMYK 00 00 00 00

**BLACK**

CMYK 0 0 0 100
OVERVIEW
The language we choose to tell our stories fall flat if it’s not supported by solid typography and hierarchy. Good type practices enhance our messaging and make our voice clearer. Consistent, thoughtful use of typography is one of the most important foundational pieces of building brand equity. This section outlines how to use type to enhance our messaging.

FOR MORE EXAMPLES
See the Sample Tactics section for more examples of the elements and practices outlined in this section.
Gotham is an all-purpose typeface that we use in most instances. Its variety of weights and styles allows for incredible flexibility across all communications. However, with so many options available, consistency is key to maintaining hierarchy and brand equity. Not all weights and styles are used equally or interchangeably, so be sure to follow these guidelines when setting text.

### PRIMARY TYPEFACE
**GOTHAM**

### MOST-USED WEIGHTS

#### GOTHAM ULTRA ALL CAPS
Headlines and quotes

<table>
<thead>
<tr>
<th>ABCDEFGHIJKLMNOPQRSTUVWXYZ</th>
<th>0123456789</th>
</tr>
</thead>
</table>

#### Gotham Bold
Headlines, subheads, body copy, callouts

| Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz | 0123456789 |

#### Gotham Book
Body copy, callouts

| Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz | 0123456789 |

#### Gotham Light
Headlines, body copy, callouts

| Aa Bb Cc Dd Ee Ff Gg Hh Ii Jj Kk Ll Mm Nn Oo Pp Qq Rr Ss Tt Uu Vv Ww Xx Yy Zz | 0123456789 |

### ALL WEIGHTS

**ULTRA**
- Black
- Bold
- Medium
- Book
- Light
- XLight
- Thin

**ULTRA**
- Black
- Bold
- Medium
- Book
- Light
- XLight
- Thin

### PUBLISHER
**Hoefler & Co.**
For access and licensing information, contact the Office of Marketing and Communication.

### ALTERNATIVE TYPEFACE
**Franklin Gothic**
Please use Franklin Gothic as your first choice for an alternative typeface to Gotham; use Arial if Franklin Gothic is not available. These typefaces may not have all the same weights available, but the same general rules apply.
Vitesse is the accent typeface we use to support Gotham. It feels like a modern take on the classic collegiate block lettering, and pairs well with UHart’s Block H. Vitesse is used for subheads, callouts, numbers, tags, and page navigation. The Medium weight is used most frequently, but other weights can be used for legibility at small scale. Bold should be used sparingly and only at small scale.

### MOST-USED WEIGHTS

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Most Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vitesse Light</strong></td>
<td>Large numbers, subheads</td>
</tr>
<tr>
<td><strong>Vitesse Book</strong></td>
<td>Subheads, callouts, numbers</td>
</tr>
<tr>
<td><strong>Vitesse Medium</strong></td>
<td>Subheads, callouts, numbers, tags, page navigation</td>
</tr>
<tr>
<td><strong>Vitesse Bold</strong></td>
<td>Callouts and numbers</td>
</tr>
</tbody>
</table>

### ALL WEIGHTS

<table>
<thead>
<tr>
<th>Weight</th>
<th>Black</th>
<th>Bold</th>
<th>Medium</th>
<th>Book</th>
<th>Light</th>
<th>Thin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Bold</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Medium</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Book</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Light</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Thin</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

### Publisher

Hoefler & Co.
For access and licensing information, contact the Office of Marketing and Communication.

### Alternative Typeface

There is no alternative typeface for Vitesse. Use a lighter weight of Gotham, Franklin Gothic, or Arial instead.
Use the samples in this section as a guide for creating new compositions. These are intended to show general hierarchy and size relationships. They are not the only ways to incorporate our typefaces, but we should be consistent and purposeful when selecting and setting type.

**LOREM QUIAE PTUSAMUS, SAMUSDA NIS EXPE VENDIT.**

1. Net omnimis doles vero quae. Occullest ut quam acers dis


3. Aut arcimin ni volore, sunt aacpedi tatusant int, quaes aut fugia accon.

**MORE EXAMPLES**

To see this copy in layout, see the Sample Tactics section.

1. **HEADLINE**
   - Gotham Ultra All Caps
   - Size: 30 pt.
   - Kerning: Optical
   - Tracking: 0
   - Space after: 0.5 in.

2. **SUBHEAD**
   - Vitesse Book
   - Size: 12 pt.
   - Leading: 16 pt.
   - Kerning: Optical
   - Tracking: 0
   - Space after: 0.25 in.

3. **BODY**
   - Gotham Book
   - Size: 9 pt.
   - Kerning: Optical
   - Tracking: 0

4. **LARGE CALLOUT**
   - Vitesse Bold
   - Size: 12 pt.
   - Leading: 16 pt.
   - Kerning: Optical
   - Tracking: 0

5. **SMALL HEADLINE**
   - Gotham Bold All Caps
   - Size: 7.5 pt.
   - Leading: 9 pt.
   - Kerning: Optical
   - Tracking: 200

6. **SMALL CALLOUT**
   - Gotham Book
   - Size: 8 pt.
   - Kerning: Optical
   - Tracking: 0

5 **BEREHNDCI DELLABO.**

6 Aditat ut ad untotae nobis et molur modit estinust, tes et eum enihil lor ipietum fugitas sitiscia maisam facepra

Qui sumqui cumquia volupit hillent quodi ut aliquo con et aut fuga. Neque nimendi occulle cestrun dition. Ad eum rero te des veliquaeate dicienimi, invendes vent doluptius vitatio volupti doluptas et, ea namus et officto dest eictem expernam dest, con exces mos et faccum corruptist del maximus esto tem laturior ma id quam invelibus qui ut occabore peligni atemolu ptatisquam sitatio torestius cus, sinvend elluptatis accumque verum ut que noneces cullenia imodit, si cus, sit pre nient que magnatur arum et is aspid ut acepudam voluptae minctae. Ebitaturion cupitate pere ex eariae rioriore nimosam etur andipsundis sum nimusdae vendaeri dit acea dolor sediaes seri anda perions equidestrum,

Gentem reperro quia sed quatiis quis estint. Ment et earcia solupis illupta turerum suntiatur rescias dis eum audae voloribus eos explit officia.
LARGE IMPACT LINE.

PUDAM EAT IUM AUDI NIAS DOLUPTATEM.

OFFIC TEM DOLORIT VOLUPTA AUTA EXCEPUD ITIATATUR AUO BERFERUM ACIAECTE DOLUS.
MORE EXAMPLES
To see this copy in layout, see the Sample Tactics section.

1 “

2 TO ODIS DOLUATUR, QUAM QUIDELL ABORROVID QUI CON PREREPE RERIBUSA QUIA AS QUE EUM ULLABO. ET ET UNT UTATIOR EPTUSANT.”

3 STUDENT NAME ’18

1 “

4 MUS, OFFICAESQUE NECEAQUIS VELIQUAM VOLESTO ET QUELOEM NOBITIAM CON NECT.”

5 —QUOTE AUTHOR

6 [234]

7 Gentem reperro quia sed quatiis quis estint. Ment et earcia solupis illupta

8 99%

7 Gentem reperro quia sed quatiis quis estint. Ment et earcia solupis illupta turerum

1 QUOTATION MARK
Vitesse Black Outlined
1 pt. stroke

2 LARGEQUOTE
Gotham Ultra All Caps
Size: 16 pt.
Leading: 18 pt.
Kerning: Optical
Tracking: 0

3 QUOTE AUTHOR
Vitesse Medium All Caps
Size: 8 pt.
Leading: 9 pt.
Kerning: Optical
Tracking: +200

4 SMALLQUOTE
Gotham Ultra All Caps
Size: 10 pt.
Leading: 13 pt.
Kerning: Optical
Tracking: +30

5 QUOTE AUTHOR
Gotham Medium All Caps
Size: 7 pt.
Leading: 9 pt.
Kerning: Optical
Tracking: +200

7 CALLOUT
Gotham Book
Size: 8 pt.
Leading: 11 pt.
Kerning: Optical
Tracking: 0

6 TAG
Vitesse Medium
Size: 9 pt.
Leading: 11 pt.
Kerning: Optical
Tracking: +200
Baseline shift for brackets: 1 pt.
Inset value for text box: 0.0625 in.

8 LARGE NUMBER
Vitesse Book
Size: 16 pt.
Kerning: Optical
Tracking: 0

[TYPGRAPHY]
# Architecture

- Acoustical Engineering and Music, BSE

# Mechanical Engineering

- Concentration in Acoustics, Energy, Sustainability, Manufacturing, or Turbomachinery available

# Civil, Environmental, and Biomedical Engineering

- Concentration in Environmental Engineering available
- Concentration in Environmental Engineering or Pre-Med available
Using type thoughtfully is crucial to making our designs look professional. Follow these tips to make sure our typography is consistent. Line spacing, called leading, is critical to setting professional-looking type that’s easy to read. Leading should be set tight, but not too tight. With our typefaces, text generally looks best with leading set slightly looser than the default.

### LEADING BODY COPY

**Leading that’s too loose leaves too much pause between lines.**

- **19 PT. TYPE / 35 PT. LEADING**  
- **18 PT. TYPE / 32 PT. LEADING**  
- **17 PT. TYPE / 29 PT. LEADING**

**This leading is too loose.**

| Alibus in et moditatque et quae venda volut lis nonse comniscit ullis estis solent odissitis. |

**Leading that’s too tight leaves too little pause between lines.**

- **21 PT. TYPE / 18 PT. LEADING**  
- **20 PT. TYPE / 15 PT. LEADING**  
- **19 PT. TYPE / 12 PT. LEADING**

**This leading is too tight.**

| Volestis asinto to vendaectore esem cupitate nientibus ducil maiorum aut que dolorpora aut. |

**When leading is correct, the reader won’t even notice.**

- **21 PT. TYPE / 23 PT. LEADING**  
- **20 PT. TYPE / 21 PT. LEADING**  
- **19 PT. TYPE / 19 PT. LEADING**

**This leading is correct.**

| Ibusdam, sunt quatqui quo velecum rest, que etum haritatem vendebis nem de optata vel int. |

### HELPFUL HINT

Start with leading that’s two points higher than the point size of the text. This won’t always be right, but leading can be adjusted most easily from there.

Smaller blocks of text may need more open leading.
LEADING HEADLINES AND SUBHEADS

Headline leading will usually be a little tighter. This is because we typically set our headlines in a boldface and full caps, which means we don’t have to worry about ascenders and descenders crowding the space between lines. Headlines set at small point sizes may need more leading than headlines set at larger point sizes. Trust your eye, not the number. If it looks too tight, it probably is.

TOO MUCH LEADING

X 35 PT. TYPE / 42 PT. LEADING

CORRECT LEADING

✓ 35 PT. TYPE / 31 PT. LEADING

NOT ENOUGH LEADING

X 35 PT. TYPE / 26 PT. LEADING

CORRECT LEADING

✓ 20 PT. TYPE / 18 PT. LEADING

CORRECT LEADING

✓ 10 PT. TYPE / 10 PT. LEADING

HELPFUL HINT

Start with leading that’s two points less than the point size of the text. This won’t always be right, but leading can be adjusted most easily from there.

We want to be sure our headlines can be read quickly and easily, and leading that’s too tight at small point sizes makes this difficult.
Due to the bold, heavy nature of our headline typefaces, we need to pay extra attention to tracking when setting headlines. Letters should be snug, but not so tight that they touch. Too much tracking makes it harder to read quickly. While it’s useful to set tracking for entire lines, sometimes the space between two letters becomes too much. Manually adjust this space using kerning.

**HELPFUL HINT**

Trust your eye. The best tracking for each typeface varies. What works for some typefaces will not work for others.

The size and weight of the typeface can also influence how much tracking is necessary. Smaller sizes and heavier weights typically need more.

**10 PT. TYPE / +80 TRACKING**

We use slightly open tracking when using Gotham Bold in All Caps headlines.
OUTLINED TYPE

Outlined type is a graphic element that can add style and depth to a composition. It should be used for brief, impact moments, not for large blocks of text and not at small sizes. These samples show a few basic ways this technique can be used, but they are not finished compositions. Use outlined type with color, layers, stroke weight, and other elements to create different effects for a variety of applications.

TYPE

Outlining should only be used with Gotham Ultra. All caps is preferred, but sentence case may also be used effectively.

This treatment works best on text that’s 40 pt. or bigger. The type becomes illegible at smaller sizes. The amount of tracking between characters may also need to be increased for legibility.

Do not use this technique for large blocks of text. It’s best for a few words, short phrases, and numbers.

STROKE

Stroke weight should be between 0.5 pt. and 3 pt. depending on text size. Use middle stroke alignment only.

USING WITH PHOTOS

This treatment may be used over top of photography. Again, this works best with large type and fewer words. Use stroke weight and color to ensure that there’s proper contrast between the text and the photo.
The University of Hartford has a robust set of graphic elements. This section outlines the best ways to use them and things to avoid.

**NEED ASSETS?**
Contact Office of Marketing and Communication for access to the graphic elements outlined in this section.

**FOR MORE EXAMPLES**
See the Sample Tactics section for more examples of the elements and practices outlined in this section.
Patterns can add depth and detail to compositions. These patterns each have their own unique traits, but they can be manipulated with scale and color to create a variety of effects for many applications. Conceptually, patterns represent individuals coming together to make each other stronger, just like the UHart community. **Only the patterns on this page should be used.**

**Chainlink**
- geometric, intersections, ornate, strong

**Deco**
- geometric, intersections, ornate, rigid, strong

**Honeycomb**
- honeycomb, geometric, intersections, strong

**Flow**
- organic, free, energy, movement, soft

**Crystal**
- geometric, connections, strong, dynamic, energy, sharp

**Triangles**
- geometric, intersections, strong, connections, sharp, energy, dynamic

**Blocks**
- geometric, design, production, mathematical, connection

**Freeform**
- organic, movement, free, forming, abstract, flowing

**Cells**
- geometric, floral, strong, sharp, protective, scientific

**Waveform**
- organic, mathematical, musical, movement, connection
Changing the scale of patterns can produce a wide variety of effects. Increased scale can add clear space, but too much may make the pattern hard to recognize. Smaller scales can make compositions feel dense, so use caution with color and type. Colors shouldn’t contrast too much, and type should stand out. Small and thin type may be difficult to use on top of dense patterns. Choose legibility over style every time.
Color variance is another way to produce many different effects using the same patterns. When applying color to a pattern, consider legibility, mood, and vibrancy, but also consider foreground and background. The colors should make sense with the rest of the colored elements in the composition, such as type and photography.

To create better legibility, use colors with similar values or monochromatic colors. To create bolder compositions, use vibrating colors and colors with high saturation. Gradients may also be used, but only the combinations shown here.

**Value**
The lightness or darkness of a color.

**Saturation**
A range from pure color (100%) to white (0%). A pure color is fully saturated.
The Block H is a heritage mark that can be used as a graphic element. It is not a substitute for the University Wordmark. However, it can be used more prominently in some instances, such as a supergraphic for internal and informal communications. Below are some examples of how the Block H can be used as a graphic element in communications. For more examples, see the Sample Tactics section.

**OVERVIEW**
The Block H can be used at various scales, from small icon to large supergraphic, and it can be solid or outlined.

**SCALE AND CONTRAST**
Either version can be used as a matter of design preference; however, consideration must be given to scale and contrast.

The solid H is more legible at the smallest scale and on busy backgrounds. The outlined H feels lighter and more modern, and works better at large scales.

**LINE WEIGHT**
When using the outlined H, the preferred line weight is 1 pt. at all scales. The weight may decrease at small scales to no less than 0.5 pt. The weight may increase to no more than 5 pt. at the largest scale.

**COLOR**
The Block H should be set in UHart Red or white in external communications and in most other instances. Other colors can be used for the outlined H in limited instances, such as internal communications or special events. If you use a color other than UHart Red for the Block H, the University wordmark should be present in UHart Red.
The outlined Block H can be used as a framing graphic in some cases. It’s a visual metaphor for students who break through barriers to become who they were meant to be. UHart gives students structure and support (represented by the frame H), and they use that to push themselves further than they thought possible (breaking through). The H frame can also be used to frame details and objects.
The following steps outline how to create a frame using the outline Block H in Adobe InDesign. Each composition will be unique and have its own needs, so be sure to adjust accordingly. This treatment may not work for every photo, so don’t try to force it. A high-resolution version with more exact cutouts can be made in Photoshop. The method on this page works for most instances.

**PICK A PHOTO**

The photo should have a clear subject and focus, with enough depth and contrast between subject and background, and shouldn’t be too busy to see the thin lines of the H. If it’s within your skill set, use Photoshop to manipulate the color and contrast of the photo as needed.

**POSITION THE H**

Use the H to frame the subject. There should be balance between what’s in frame and out of frame. If the frame covers the subject’s face, be sure this area can break through. If it can’t break through, you need to reposition the frame so as not to cover their face.

**FIND BREAKTHROUGHS**

While positioning the H, look for pieces of the photo that make sense for breaking through the frame. Treat the H as a physical object within the composition. What is its depth relative to the subject? In this photo, her hands, arms, torso, and head make sense to break through the frame.

**SLICE THE H**

Using the Add Anchor Point tool, select the H frame and add anchor points where you want the photo to break through the frame (blue points). Using the Direct Selection (A) tool, select only the parts of the frame you wish to remove and press delete. This should result in your final frame.

**DETERMINE THICKNESS**

You may need to alter the stroke thickness of the frame H for better legibility. Generally speaking, this value will stay between 0.5 pt. and 3 pt. The stroke should only be as thick as it needs to be for minimum legibility. It feels less sophisticated if it’s too thick and becomes too imposing on the photo subject.

**Tip:** Once the H has been sliced and the unwanted segments removed, group the remaining segments for easy adjustments.

---

**TIPS AND TRICKS**

**Framing**

What’s the most important focus of the photo? The subject? What are they doing or holding? Be purposeful with placement.

**Does it look like an H?**

Be sure that the frame still looks like an H after placement. It’s ok for the H to bleed the off the edges, but too much makes the H look like an I or a pair of columns.

**Breakthroughs**

Avoid too many frame breaks so that the H remains legible after it is sliced.

**Color**

White is the preferred color, followed by UHart Red. If another color is still desired, pick a color from the secondary palette that matches a color in the photo, or provides interesting contrast to the colors in the photo.
This page shows things that should be avoided when creating frames with the Block H. It’s best to not force it. This treatment will not work in all instances, and should be reserved for impact moments and important features. It works best with a clear focus, lots of background space, and some depth of field. For more examples, see the Sample Tactics section of these guidelines.

**SCALE, PLACEMENT, AND BREAKTHROUGHS**

- Proportional scale, logical slices, consistent depth, and legible H.
- Too many slices and inconsistent depth (see legs and bench).
- H is scaled too big, hard to see, covers subject too much.
- H is scaled too small, no room for breakthroughs, constricts subject.

**PHOTO SELECTION**

- Cropped too tightly on subject’s face. Choose a photo with more clear background space.
- Never obstruct performers or artists. Use icon H or place it behind them with good legibility.
- Foreground object throws off depth between subject and H. Choose another photo.
- No clear subject or focus in the photo and no interaction. Choose another photo.

**LINE WEIGHT AND COLOR**

- Line weight too thin, H gets lost on busy photo background. Increase line weight.
- Line weight too thick, makes H feel heavy and subject feel constricted. Decrease line weight.
- Poor contrast between H and busy photo background. Use color to make the H pop.
- Poor color contrast between H and photo background. Red would be better in this case.
Use lines to divide or connect blocks of copy, callouts, photos, and other visual elements. This sample illustrates a variety of ways to use line work. Too many lines make for busy compositions; try not to use more than three lines per spread, unless absolutely needed. See the Sample Tactics section for more examples in layout.

**NOTE** Line weight should be between 0.5 pt.–2 pt.
Use an abstracted photo frame to add depth and visual interest to a composition. This treatment calls attention to large featured photos or smaller photos that are of special interest.
This is a step-by-step guide to creating abstracted photo frames. Not all users are equipped to create or use this treatment.

HOW TO MAKE ABSTRACTED PHOTO FRAMES

SELECT A PHOTO
Choose a photo that has good contrast and depth between subject and background. This treatment works best when there is a balance of colors and textures, as opposed to a uniform background.

FRAMING
The red box represents the area the whole photo object needs to fill. The blue box represents the “safe area” the portrait will live in. The area in between the two becomes the abstracted photo frame. Generally, the frame should be between 0.5 inch and 0.75 inch, but depending on the size of your composition and the amount of contrast in the photo, anywhere between 0.25 inch and 1 inch is acceptable.

CROPPING AND SCALING
Copy and paste the photo into the blue frame. Adjust scale and cropping as needed. The subject should be the clear focus and centered in the frame if possible.

MANIPULATE BACKGROUND
To create the abstracted frame, use simple transformations to the photo in the red box. The simplest method is to flip the photo vertically and again horizontally, and then increasing the scale until there is enough contrast.

MAKE FINAL ADJUSTMENTS
Once the background image has been transformed, the photo frame should be close to finished. Make additional adjustments to the cropping and scale of both images until proper contrast and the desired look are achieved. This process will be iterative and may take some finessing to achieve the right effect.

NEED MORE CONTRAST?
If more contrast is needed between the portrait and the frame, use a color overlay on the frame (but under the portrait). Set this flood to Black + Multiply blend or White + Overlay blend. Keep the transparency relatively low, generally between 10% and 40%. This technique should only be used when it is absolutely needed.

These frames should be used sparingly, at most once per page or spread, and only a few times throughout a longer piece. This is a supporting visual element, and not one that should be featured frequently.
**Arrow Notches and Anchor Bars**

Arrow notches and anchor bars are used to indicate direction, connect photos to copy, or call attention to items of interest. While the scale of the arrows can change, the shape should always remain the same.

Related content should always be adjacent to the arrow. The arrow notch and anchor bars should be used purposefully. Avoid using them too frequently in one composition.

**Notch In**

If you wish to create a notch in the frame, simply convert the arrow to the color of the background.

**Notch Out**

To create a notch out, use the Pathfinder tool to Add the arrow with the frame. Alternatively, copy the photo from the frame and use Paste Into to place the photo in the arrow notch.

**Anchor Bars**

Start with one of the three anchor bars provided in the graphic elements package. If the bar needs to be longer, scale the bar while holding the Shift key to maintain the proportions, or use the Direct Selection tool to move either end point. The Direct Selection tool can also be used to move the arrow while keeping the end points in place.

The anchor bar can be used horizontally or vertically, and the arrow can point up, down, left, or right, but it should always point to or connect content. Use one of the five weights shown here (the default weight is 1 pt). If you’re using anchor bars in large-scale productions, such as banners, you may scale up the stroke weight accordingly.

See the Sample Tactics section of these guidelines to see anchor bars and notches used in layout.
OVERVIEW

Photography allows us to tell authentic stories in a single moment. Photos are one of the hardest-working and most-valued assets available. Take great care and be thoughtful when selecting photos. Be sure that they’re relevant and add value to the composition.

FOR MORE EXAMPLES

See the Sample Tactics section for more examples of the elements and practices outlined in this section.

NOTE

Select photographs used in this section are brand examples and have been noted as such. The University does not own the artistic rights for their use in other communications, and they should serve only to guide photo style.
Student photography should feel warm and genuine. Use a good mix of candid portraits of individuals, focused shots of collaboration in and out of the classroom, and students hard at work perfecting their craft or hitting the books. Posed portraits are good for student feature stories. Performing and fine arts materials should showcase student performances and artwork, but also the related practice and process.

Select photographs used in this section are brand examples and have been noted as such. The University does not own the artistic rights for their use in other communications, and they should serve only to guide photo style.
Faculty photography should focus primarily on the relationship between faculty and their students. Show personal moments and authentic connection. Show collaboration on research and open dialogue. Posed portraits are good for faculty features, but they should feel distinguished and warm. The same rules apply for featured alumni, but be sure to also show them as working professionals or making an impact in their communities.
PHOTOGRAPHY

PLACE

Portray our location exactly as it is, choosing photos of campus at its best. Select photos with warm lighting, highlight the beauty of our setting, and feature new buildings and facilities when possible.

Interior shots should be brightly lit if possible. Campus looks best when people are present, but balance people and beauty shots. Use photos that portray downtown Hartford as modern, dynamic, and engaging.

Select photographs used in this section are brand examples and have been noted as such. The University does not own the artistic rights for their use in other communications, and they should serve only to guide photo style.
Detail photography includes simple, interesting images that give readers a break in content-heavy compositions. Use them thoughtfully. These photos can fill in the gaps, but the right shot can make for a cool feature. Detail photos allow us to tell parts of the story that copy can’t alone, especially in creative processes. Use them to showcase student inventions, artwork, creations, and processes.
Duotones can add style and texture to a composition, but they are better used for moments of impact and for making bold statements. Pair a featured story or quote with a high-contrast duotone portrait. Flood an entire page with a duotone for extra vibrancy. Duotones lose their impact if they’re used too frequently, and many photos will not make suitable duotones, so use discretion.

Select photographs used in this section are brand examples and have been noted as such. The University does not own the artistic rights for their use in other communications, and they should serve only to guide photo style.
Use this step-by-step guide to create duotone images in Adobe Photoshop. Each photo is unique and the same result may not be achieved every time. Duotone images should only be created by users who have Photoshop and a basic understanding of its functions. For guidance on color selection, see page 85. For more examples of duotone photos in layout, see the Sample Tactics section.

**PHOTOGRAPHY**

**HOW TO MAKE DUOTONES**

**PAGE 1 OF 2**

---

**SELECT A PHOTO**

This duotone effect works best for studio portraits, but can be used on photos with dark backgrounds and images with good contrast between subject and background. The previous page has good examples of appropriate photos and treatments.

If the portrait was not shot in studio, use a Layer Mask and the Brush tool to remove the background of the photo. Be precise and get as close to the edge of the subject as possible.

---

**CONVERT TO BLACK AND WHITE**

Add a Black & White adjustment layer, either by using the Adjustments panel or the Adjustments quick menu at the bottom of the Layers panel.

Press Auto in the upper right corner of Black & White properties panel. Use the sliders to make some initial contrast adjustments, increasing the contrast between the lightest and darkest parts of the photo.

---

**ADJUST LEVELS AND CONTRAST**

Add a Levels adjustment layer on the top most layer, either by using the Adjustments panel or the Adjustments quick menu at the bottom of the Layers panel. Use the sliders to further increase contrast between light and dark.

This will create a more dramatic effect when the duotone conversion is made. There should be just a little bit of blow-out, but not so much that you lose important details.

---

**Using a Layer Mask**

Select the layer you wish to mask, then press the Add layer mask button, located at the bottom of the Layers panel.

Next, select the Layer mask itself, not the layer the mask is applied to. This will ensure you are affecting the mask, not the photo. Use a hard brush and set the color to black (#000000). Painting with this brush on the mask will “erase” the photo without permanently destroying the photo. Paint with a white (#FFFFFF) brush on the mask to undo previous masking, showing the photo underneath again.

---

The photograph used in this section is only a brand example. The University does not own the artistic rights for its use in other communications, and they should serve only to guide photo style.
To convert the photo to a duotone, you must first convert it to grayscale. In the Menu bar, navigate to Image > Mode > Grayscale. You can choose to merge or keep layers, and discard color information. Either is fine, so choose what looks best. You can always go back using Edit > Step Backward (⌘+Z). The grayscale adjustment layer will disappear, but this is okay.

Once the photo is in grayscale, use the Menu bar to navigate to Image > Mode > Duotone. A modal dialogue box will appear.

Set the first color to be the lighter color and the second color to be the darker color. To do this, double-click each swatch and enter the proper color formula. Use CMYK for print and RGB/Hex for digital.

Use another Levels adjustment layer to increase or decrease the amount of contrast and blow-out. In this example, Levels was used to increase the amount of white pixels, resulting in a slightly blown-out effect.

Before exporting to a .jpg or .png, convert the color mode from duotone to CMYK for print or RGB for digital. Do this by navigating to Image > Mode > CMYK or RGB. Merge layers if desired. You can undo this using Edit > Step Backward (⌘+Z). However, this only works in the same working session. Once the file is closed, you will lose your history from that session. If you wish to save the layers for editing later, use Save As... and create a copy of the Photoshop file.

Now you can export your image for use in other applications by navigating to File > Save As... Please note that .png files can only be created if the color mode is set to RGB.

See the next page for guidance on choosing appropriate color combinations for duotone photos.
This page highlights some of the best color pairings for duotone images. These are not the only color combinations you can use. When choosing your own colors, be sure there is strong contrast between the subject’s color and the background color. Avoid really vibrational combinations or ones that are very dark. It’s okay to be bold, but be mindful of context and audience. For guidance on how to make duotones with Photoshop, see the previous two pages.

Medium Purple on Light Gray

Medium Purple on Light Yellow

Dark Blue on Medium Green

Dark Green on Light Blue

Dark Green on Light Green

Medium Purple on Light Blue

UHart Red on Light Gray

Dark Blue on Light Yellow

Dark Blue on Light Blue

UHart Red on Light Blue

Dark Yellow on Light Yellow

Medium Purple on Medium Blue

Too little contrast

Tones vibrate too much

Both tones are too dark, no contrast

Light on dark looks like an x-ray

Dark tones on UH Red look bloody

The photograph used in this section is only a brand example. The University does not own the artistic rights for its use in other communications, and they should serve only to guide photo style.
There are a number of things to think about when creating materials—from audience and message to graphics to colors. Use these tools when thinking about how to craft your communications.

NOTE
This section is intended for internal use only.
**Design Elements**

**Primary Typeface**
- Gotham Light
- Gotham Book
- Gotham Medium
- Gotham Bold
- Gotham Black
- Gotham Ultra

**Accent Typeface**
- Vitesse Light
- Vitesse Book
- Vitesse Medium
- Vitesse Bold
- Vitesse Black

**Graphic Elements**
- Block H Frame
- Abstracted Photo Frame
- Lorem Ipsum Nuit
- [College of]

**Patterns**

**Color Palette**
- Primary
- Secondary
- Neutrals
- Gradients
TEMPLATES

Templates are available for you to use to help you create branded materials. There are currently templates for the items shown below. Contact the Office of Marketing and Communication for the files for these templates.

STANDARD AND WIDE SCREEN POWERPOINT PRESENTATIONS

TITLe LINe 1
TITLe LINe 2
TITLe LINe 3

Subhead line 1
Subhead line 2

OCTOBER 01, 2018

Sample Title
Subhead 1
Subhead 2

9X6 POSTCARD

COLLEGE OF ENGINEERING AND TECHNOLOGY

MAKING AN IMPACT ON THE NEXT GENERATION OF LEADERS
The LEAD Class of 2019

RESUME CRITIQUE DAY

Are you looking to network with employers, but not sure your résumé is ready? We can help! Visit with UHart’s Career Services counselors. Be sure to bring your résumé.

MONDAY, MARCH 12
10:30 A.M.–3:30 P.M.
CETA Student Lounge

8.5X11 FLYER

COLLEGE OF ENGINEERING AND TECHNOLOGY

Are you looking to network with employers, but not sure your résumé is ready? We can help! Visit with UHart’s Career Services counselors. Be sure to bring your résumé.

MONDAY, MARCH 12
10:30 A.M.–3:30 P.M.
CETA Student Lounge
Using a creative brief for projects makes it easy for communicators to identify their content priorities. It also ensures that each communication carries a consistent voice and a strong message that focuses on what benefits the audience.
TIE IT BACK TO THE MESSAGING MAP

<table>
<thead>
<tr>
<th>IF THEY REMEMBER ONE THING, WHAT SHOULD IT BE?</th>
<th>WHAT ARE THE REASONS THEY SHOULD BELIEVE THIS?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Uncoated paper has a more organic and high-touch quality than coated—or glossy—paper. University of Hartford printed materials should be produced on an uncoated paper stock. Below are specifications for our most common pieces. For advice on choosing a paper stock, please contact the Office of Marketing and Communication.

**UNCOATED PAPER**

Cougar Smooth by Domtar
Accent Opaque by International Paper

**COATED PAPER**

Endurance by Veritiv
Opus by Sappi

**Formal Invitation and Envelope**

Size: 8.5x5.5" | envelope: 6x9"
Paper stock: 100# cover

**Response Card and Envelope**

Size: 5x7" | envelope: 5.25x7.25" or A7
Paper stock: 100# cover

**Panel Card and Envelope**

Size: 8.5x5.5" | envelope: 6x9"
Paper stock: 100# cover

**Postcard**

Size: 8.5x5.5"
Paper stock: 100# cover

**Tri-fold Brochure**

Size: 8.5x3.6" or 4x9" folded
Paper stock: 100# text
TRADEMARK NOTICE

The University of Hartford and “UHart” name, logo and trademarks, wordmarks, slogans, and other identifying symbols are the property of University of Hartford and are protected by statutory and common-law. Any unauthorized use of these or misleadingly similar names or marks, by any entity or individual without express written consent of University of Hartford will be deemed a violation of the University’s proprietary rights, and the University will take any and all steps necessary to protect such rights. Commercial use and reproduction without express written permission is strictly prohibited. This includes use by nonbusiness groups or individuals, employees, charities, and other organizations. The use of any University of Hartford name, logo, or trademark on any product or in connection with a manufacturer, wholesaler, screen printer, in-store producer, or any other supplier must be managed under a written agreement; other commercial use and reproduction without express written permission is strictly prohibited.

The name “University of Hartford” and the “AD HUMANITATEM” logo are registered with the U.S. Patent and Trademark Office. University of Hartford holds exclusive ownership rights regarding the use of all University logos, names, and trademarks. Only the official, approved versions of the logo are appropriate for use.

Those logos and trademarks must be used according to the University’s approved graphic standards. They must not be re-keyed, redrawn, repportioned, added to, or modified in any way. They are official trademarks of the University of Hartford and must be reproduced from original artwork. Only the official, approved versions of the logos and trademarks are appropriate for use. The Office of Marketing and Communication and the Department of Athletics are responsible for establishing and maintaining these graphic standards, as well as formally approving any external use of University trademarks.
TRADEMARK USAGE GUIDELINES

EXTERNAL TRADEMARK USE

The use by any external organization, business, or individual of any University of Hartford name, logo, or trademark must be approved by the University’s Office of Marketing and Communication and/or Department of Athletics prior to use. This serves to protect the reputation of the college and the integrity of the marks by ensuring that only approved representations of the University’s marks appear before the public.

Monitoring use of the trademarks also ensures University of Hartford’s compliance with United States trademark laws.

COMMERCIAL USE OF TRADEMARKS

Commercial use of the University of Hartford names, symbols, and logos must be approved and licensed in advance. Items bearing those names, symbols or logos that are purchased or produced for promotional use or resale must be purchased from a licensed supplier only. This includes merchandise purchased by staff from third parties, retail items, promotional partnerships, and other uses of University of Hartford’s trademarks by any entity or individual other than University of Hartford.

It is an infringement on University of Hartford’s registered names, logos, and trademarks to produce University of Hartford merchandise without written authorization. Vendors who fail to follow this policy may lose license permissions and the ability to do business with University of Hartford. Legal penalties also may apply.

Use of the University’s names, logos, and trademarks are approved through University of Hartford’s Office of Marketing and Communication and Department of Athletics to ensure that the marks are used according to design standards, and to protect University of Hartford’s ownership of the marks.

When in doubt about any form of logo or trademark usage pertaining to the University, contact University of Hartford’s Office of Marketing and Communication.

MERCHANDISE PRODUCTION

The University has enacted certain specifications in connection with the University’s name, logos and trademarks for branded merchandise, such as ink and embroidery thread colors. So-called “UHart Red,” black, white, and grey are the primary colors permitted for that merchandise; special exceptions such as merchandise promoting breast cancer awareness or celebrating holidays are permitted on a case-by-case basis. This merchandise must be ordered from licensed vendors approved through the University’s Procurement Department.

Licensees must seek trademark-use approval through our licensing agency, Learfield Licensing Partners. Only authorized licensees are permitted to resell University of Hartford branded merchandise.
Student clubs and organizations should not use the University or Athletics logos, trademarks, wordmarks, slogans, and other identifying symbols—or any part thereof—on flyers, merchandise, apparel, or other promotional materials. The only exception to this is the Student Government Association, which has its own official wordmark. This should be used when SGA members are officially representing the University to external partners. Use of any official University or Athletics logos must be approved by the Office of Marketing and Communication or Athletics Department prior to production.

Student clubs and organizations may create their own graphics for on-campus (internal) use; here are some guidelines to keep in mind:

- With permission, and subject to the University’s right to provide input, officially-recognized student clubs and organizations can use the words “University of Hartford,” but cannot use the University or Athletics wordmarks or logos, in part or in full. The typeface chosen should not mimic our official wordmarks or logos.

- When communicating to an off-campus (external) audience, student clubs and organizations should seek permission from the Office of Marketing and Communication—through their Student Government Association administrators—to use any notation that reasonably can be considered to identify the University on any materials (digital, print, apparel, merchandise).

- Any use of the University’s trademarks (whether the wordmark or the Athletics logos) must be approved by the University’s Office of Marketing and Communication or Department of Athletics prior to production. This applies to print, web, merchandise and apparel, video, etc. Allow 3–5 business days for review of items, depending on the complexity and level of priority.

Students may order small quantities of business cards from Print Services. A standard template must be used, and the following guidelines must be followed.

- Layout is restricted to the example shown at left.

- Only the official University of Hartford or University of Hartford school wordmark may be used, no tagline or additional copy below it.

- Student names must include their class year, as shown.

- The “title” line must include “Candidate for...” plus the particular degree they seek.

- The address must be their on-campus address—the only exception being commuter students.

- Students can list their phone number, but the email must be their official UHart email address.

- The only social media account that can be listed is their LinkedIn account.

- The Office of Marketing and Communication must approve before printing.

- Cards must be ordered through the University’s Print Services department.